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Chapter 1 Introduction

1.1 Overview

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing
applications for the RA microcontroller series.

1.2 Using this Manual

This manual provides a wide variety of information, so it can be helpful to know where to start. Here
is a short description of each main section and how they can be used.

Starting Development - Provides a step by step guide on how to use e2 studio and FSP to develop a
project for RA MCUs. This is a good place to start to get up to speed quickly and efficiently.

FSP Architecture - Provides useful background material on key FSP concepts such as Modules,
Stacks, and API standards. Reference this section to extend or refresh your knowledge of FSP
concepts.

API Reference - Provides detailed information on each module and interface including features, API
functions, configuration settings, usage notes, function prototypes and code examples. Board
Support Package (BSP) related API functions are also included.

Note
Much of the information in the API Reference section is available from within the e2 studio tool via the Devel oper
Assistance feature. The information here can be referenced for additional details on API features.

1.3 Documentation Standard

Each Modules section user guide outlines the following:

» Features: A bullet list of high level features provided by the module.

e Configuration: A description of module specific configurations available in the RA
Configuration editor.

e Usage Notes: Module specific documentation and limitations.

e Examples: Example code provided to help the user get started.

¢ APl Reference: Usage notes for each APl in the module, including the function prototype and
hyperlinks to the interface documentation for parameter definitions.

Each Interfaces section user guide outlines the following:

e Detailed Description: A short description and summary of the interface functionality.

e Data Structures: A list and definition of each data structure used by the interface including
the structure of the pointers that define the API and are shared by all modules that
implement the interface.

e Typedefs: A list and description of the typedefs used by the interface.

e Enumerations: A list and description of the enumerations used by the interface.
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1.4 Introduction to FSP

1.4.1 Purpose
The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide

easy to use, scalable, high quality software for embedded system design. The primary goal is to
provide lightweight, efficient drivers that meet common use cases in embedded systems.

1.4.2 Quality

FSP code quality is enforced by peer reviews, automated requirements-based testing, and
automated static analysis.

1.4.3 Ease of Use

FSP provides uniform and intuitive APIs that are well documented. Each module is supported with
detailed user documentation including example code.

1.4.4 Scalability

FSP modules can be used on any MCU in the RA family, provided the MCU has any peripherals
required by the module.

1.4.5 Build Time Configurations

FSP modules also have build time configurations that can be used to optimize the size of the module
for the feature set required by the application.

1.4.6 e2 studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RA
series of MCU devices. The e2 studio IDE provides a familiar development cockpit from which the key
steps of project creation, module selection and configuration, code development, code generation,
and debugging are all managed.
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Chapter 2 Starting Development

2.1 Starting Development Introduction

The wealth of resources available to learn about and use e2 studio and FSP can be overwhelming on
first inspection, so this section provides a Starting Development Guide with a list of the most
important initial steps. Following these highly recommended first 11 steps will bring you up to speed
on the development environment in record time. Even experienced developers can benefit from the
use of this guide, to learn the terminology that might be unfamiliar or different from previous
environments.

1. Read the section What is e2 studio?, up to but not including e2 studio Prerequisites. This
will provide a description of the various windows and views to use e2 studio to create a
project, add modules and threads, configure module properties, add code, and debug a
project. It also describes how to use key coding 'accelerators' like Developer Assist (to drag
and drop parameter populated API function calls right into your code), a context aware
Autocomplete (to easily find and select from suggested enumerations, functions, types, and
many other coding elements), and many other similar productivity enhancers.

2. Read the FSP Architecture, FSP Modules and FSP Stacks sections. These provide the basic
background on how FSP modules and stacks are used to construct your application.
Understanding their definitions and the theory behind how they combine will make it easier
to develop with FSP.

3. Read a few Modules sections to see how to use API function calls, structures, enumerations,
types and callbacks. These module guides provide the information you will use to
implement your project code.

4. After you have a Kit and you have downloaded and installed e2 studio and FSP, you can
build and debug a simple project to test your installation, tool flow, and the kit. (If you do
not have a Kit or have not yet installed the development software, use the links included in
the e2 studio Prerequisites for more information.) The simple Tutorial: Your First RA MCU
Project - Blinky will Blink an LED on and off. Follow the instructions for importing and
running this project in section Create a New Project for Blinky. It will use some of the key
steps for managing projects within e2 studio and is a good way to learn the basics.

5. Once you have successfully run Blinky you have a good starting point for using FSP for more
complex projects. The Using HAL Drivers Tutorial, available at Tutorial: Using HAL Drivers -
Programming the WDT, shows how to create a project from scratch, using FSP API functions.
Do this next.

6. Several Hands-on Quick FSP Labs are available that cover key development topics with
short 15-minute Do it Yourself (DiY) activities targeting the EK-RA6M3. Topics covered
include code development accelerators like Developer Assistance, Autocomplete, Help,
Visual Expressions and using Example Projects. The complete list of available Quick FSP
Labs can be found here: https://en-
support.renesas.com/knowledgeBase/category/31087/subcategory/31090. Doing a couple
of these labs provides further details on using FSP, and is also good practice. Running these
labs is highly recommended.

7. The balance of the FSP Architecture sections (that is, those not called out in step 2 above)
contain additional reference material that may be helpful in the future. Scan them so you
know what they contain, in case you need them.

8. The balance of the e2 studio User Guide, starting with the What is a Project? section up to,
but not including, Writing the Application section, provides a detailed description of each of
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the key steps, windows, and entries used to create, manage, configure, build and debug a
project. Much of this may be familiar after running through the tutorials and Quick Labs.
However, it is important to have a good grasp of what each of the configuration tabs are
used for as that is where the bulk of the project preparation work takes place prior to
writing code. Skim over this section as it may help with any questions in the future.

9. Read the Writing the Application section to get a short introduction to the steps used when
creating application code with FSP. It covers both RTOS-independent and RTOS-dependent
applications. It also includes a short description for several of the code accelerators you
should be familiar with by now. Using additional Quick FSP Labs is a good way to become
familiar with the application development process and links to them are included in the
appropriate places in this section. You can find the complete list of available Quick FSP Labs
here: https://en-support.renesas.com/knowledgeBase/19308277.

10. Scan the Debugging the Project section to see the steps required to download and start a
debug session.

11. Explore the additional material available on the following web pages and bookmark the
resources that look most valuable to you:

. RA Landing Page: https://www.renesas.com/ra

. FSP Landing Page: https://www.renesas.com/fsp

. Example Projects on GitHub: https://github.com/renesas/ra-fsp-examples

. Quick FSP Labs Listing: https://en-support.renesas.com/knowledgeBase/19308277

. RA and FSP Knowledge Base (with articles of interest on RA and FSP): https://en-

support.renesas.com/knowledgeBase/category/31087
f. RA and FSP Renesas Rulz site (Community posted and answered questions):
https://renesasrulz.com/ra/
g. FSP Releases: https://github.com/renesas/fsp/releases
h. FSP Documentation: https://renesas.github.io/fsp
i. Online Technical Support: https://www.renesas.com/us/en/support/contact.html

2.2 e2 studio User Guide

2.2.1 What is e2 studio?

™ QN T QD

Renesas e2 studio is a development tool encompassing code development, build, and debug. e2
studio is based on the open-source Eclipse IDE and the associated C/C++ Development Tooling
(CDT).

When developing for RA MCUs, e2 studio hosts the Renesas Flexible Software Package (FSP). FSP
provides a wide range of time saving tools to simplify the selection, configuration, and management
of modules and threads, to easily implement complex applications. The time saving tools available in
e2 studio and FSP include the following:

* A Graphical User Interface (GUI) (see Adding Threads and Drivers) with numerous wizards
for configuring and auto-generating code

* A context sensitive Autocomplete (see Tutorial: Using HAL Drivers - Programming the WDT)
feature that provides intelligent options for completing a programming element

e A Developer Assistance tool for selection of and drag and drop placement of API functions
directly in application code

¢ A Welcome Window with links to example projects, application notes and a variety of other
self-help support resources

¢ An Information Icon from each module is provided in the graphic configuration viewer that
links to specific design resources, including code 'cheat sheets' that provide useful starting
points for common application implementations.
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RENESAS

e’ studio

( BUILT ON

Figure 1: e2 studio Splash Screen

e2 studio organizes project work based on Perspectives, Views, Windows, Panes, and Pages
(sometimes called Tabs). A window is a section of the e2 studio GUI that presents information on a
key topic. Windows often use tabs to select sub-topics. For example, an editor window might have a
tab available for each open file, so it is easy to switch back and forth between them. A window Pane
is a section of a window. Within a window, multiple Panes can be opened and viewed simultaneously,
as opposed to a tabbed window, where only individual content is displayed. A memory-display
Window, for example, might have multiple Panes that allow the data to be displayed in different
formats, simultaneously. A Perspective is a collection of Views and Windows typical for a specific
stage of development. The default perspectives are a C/C++ Perspective, an FSP Configuration
Perspective and a Debug Perspective. These provide specific Views, Windows, Tabs, and Panes
tailored for the common tasks needed during the specific development stage.
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Figure 2: Default Perspective
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In addition to managing project development, selecting modules, configuring them and simplifying
code development, e2 studio also hosts the engine for automatically generating code based on
module selections and configurations. The engine continually checks for dependencies and
automatically adds any needed lower level modules to the module stack. It also identifies any lower
level modules that require configuration (for example, an interrupt that needs to have a priority
assigned). It also provides a guide for selecting between multiple choices or options to make it easy
to complete a fully functional module stack.

The Generate Project Content function takes the selected and configured modules and automatically
generates the complete and correct configuration code. The code is added to the folders visible in
the Project Explorer window in e2 studio. The configuration.xml file in the project folder holds all
the generated configuration settings. This file can be opened in the GUI-based RA Configuration
editor to make further edits and changes. Once a project has been generated, you can go back and
reconfigure any of the modules and settings if required using this editor.

&5 Project Explorer & = 8

L

~ 125 Blinky [Debug]

=Y Includes

Bra

= ra_gen

2 src

= ra_cfg

= script
= Blinky Debug_Flat.launch

i configurationxml
= R7TFABMTAD3CFP.pincfg
= RA6M1-EK pincfg

(@ Developer Assistance

Figure 3: Project Explorer Window showing generated folders and configuration.xml file

2.2.2 e2 studio Prerequisites

2.2.2.1 Obtaining an RA MCU Kit

To develop applications with FSP, start with one of the Renesas RA MCU Evaluation Kits. The Renesas
RA MCU Evaluation Kits are designed to seamlessly integrate with the e2 studio.

Ordering information, Quick Start Guides, User Manuals, and other related documents for all RA MCU
Evaluation Kits are available at https://www.renesas.com/ra.

2.2.2.2 PC Requirements
The following are the minimum PC requirements to use e2 studio:

¢ Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX
e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)
e Minimum 250-GB hard disk

2.2.2.3 Installing e2 studio, platform installer and the FSP package

Detailed installation instructions for the e2 studio and the FSP are available on the Renesas website
https://www.renesas.com/fsp. Review the release notes for e2 studio to ensure that the e2 studio
version supports the selected FSP version. The starting version of the installer includes all features of
the RA MCUs.
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2.2.2.4 Choosing a Toolchain

e2 studio can work with several toolchains and toolchain versions such as the GNU Arm compiler and
Arm ACG6. A version of the GNU Arm compiler is included in the e2 studio installer and has been
verified to run with the FSP version.

2.2.2.5 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.
2.2.3 What is a Project?

In e2 studio, all FSP applications are organized in RA MCU projects. Setting up an RA MCU project
involves:

1. Creating a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects
already, after you launch e2 studio and select a workspace, all projects previously saved in the
selected workspace are loaded and displayed in the Project Explorer window. Each project has an
associated configuration file named configuration.xml, which is located in the project's root directory.

5 Project Explorer 2 ]

1
{L(\.I

~ =% Blinky [Debug]

= Includes

Era

 ra_gen

& src

= ra_cfg

= script
= Blinky Debug_Flat.launch

i configurationxml
= RTFABM1TAD3CFP.pincfg
=/ RA6M1-EK pincfg

(@ Developer Assistance

Figure 4: e2 studio Project Configuration file

Double-click on the configuration.xml file to open the RA MCU Project Editor. To edit the project
configuration, make sure that the FSP Configuration perspective is selected in the upper right
hand corner of the e2 studio window. Once selected, you can use the editor to view or modify the
configuration settings associated with this project.

= | BC/C++ | FSP Configuration
Figure 5: e2 studio FSP Configuration Perspective

Note
Whenever the RA project configuration (that is, the configuration.xml file) is saved, a verbose RA Project Report
file (ra_cfg.txt) with all the project settings is generated. The format allows differencesto be easily viewed using a
text comparison tool. The generated file islocated in the project root directory.
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Figure 6: RA Project Report

>

The RA Project Editor has a number of tabs. The configuration steps and options for individual tabs
are discussed in the following sections.

Note

The tabs available in the RA Project Editor depend on the e2 studio version and the layout may vary dightly,
however the functionality should be easy to follow..
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Figure 7: RA Project Editor tabs
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e Click on the YouTube icon to visit the Renesas FSP playlist on YouTube
e Click on the Support icon to visit RA support pages at Renesas.com
e Click on the user manual (owl) icon to open the RA software package User's Manual

2.2.4 Creating a Project

During project creation, you specify the type of project, give it a project name and location, and
configure the project settings for version, target board, whether an RTOS is included, the toolchain
version, and the beginning template. This section includes easy-to-follow step-by-step instructions
for all of the project creation tasks. Once you have created the project, you can move to configuring
the project hardware (clocks, pins, interrupts) and the parameters of all the modules that are part of
your application.

2.2.4.1 Creating a New Project
For RA MCU applications, generate a new project using the following steps:
1. Click on File > New > RA C/C++ Project > Renesas RA.

&) workspace - e2 studio
File Edit Navigate Search Project RenesasViews Run Window Help

New Alt+Shift+N > Renesas C/C++ Project > Renesas Debug X
Open File... ™ Project. Renesas RA
L. Open Projects from File System... % Example..
R it Fil >
ecent rres [ Other.. Ctrl+N
Claca Editar el 2\ L

Figure 8: New RA MCU Project

Then click on the type of template for the type of project you are creating.

ﬁ New C/C++ Project O X

Templates for Renesas RA Project

Renesas RA C/C++ Project
CfCrs A Create an executable or static library C/C++ project for Renesas RA.
‘/?j' < Back Next > Finish Cancel

Figure 9: New Project Templates

2. Select a project name and location.
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Q Renesas RA C/C++ Project O X

Renesas RA C/C++ Project p—

Project Name and Location

Project name

| MyProjecﬂ

Use default location
\MyProject Browse...

default

You can download more Renesas packs here

'/?3' < Back Finish Cancel
Figure 10: RA MCU Project Generator (Screen 1)

3. Click Next.
2.2.4.2 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.
2. Select the Board for your application. You can select an existing RA MCU Evaluation Kit or
select Custom User Board for any of the RA MCU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection.
Only change the Device when using the Custom User Board (Any Device) board
selection.

. To add threads, select RTOS, or No RTOS if an RTOS is not being used.

. The Toolchain selection defaults to GCC Arm Embedded.

. Select the Toolchain version. This should default to the installed toolchain version.

. Select the Debugger. The J-Link Arm Debugger is preselected.

<o u b

8. Click Next.
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Note

Click on the Help icon (?) for user guides, RA contents, and other documents.

Q Renesas RA C/C++ Project

O >
Renesas RA C/C++ Project —
|Device and Tools Selection
Device Selection
ESP Version: .| Board Description
Board: EK-RABM3 v
Device: R7FABM3AH3CFC
Language: @C OC++
Device Details
TrustZone No
Pins 176
Processor cortex-m4
Toolchains Debugger
GNU ARM Embedded J-Link ARM ~
v
[@]«= Help <Back Carcel

Figure 11: RA MCU Project Generator (Screen 2)

2.2.4.3 Selecting Flat or Arm® TrustZone® Project

If you selected a device or tool based on an Arm® Cortex®-M33, you next select whether to use

Arm® TrustZone® in your project. For normal, non-TrustZone projects, select "Flat".
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ﬁ Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Type Selection

Project Type Selection

@ Flat (Non-TrustZone) Project
* RA device project without TrustZone separation
* All code, data and peripheral settings will be configured in
this project

() Secure Project

* RA device project for TrustZone secure execution

+ All code, data and peripherals placed in this project will
be initialized as secure

* Secure project settings such as TrustZone partitions, linker
maps and a list of secure peripherals will be passed to a
selected non-secure project

= After initialization, a call to the non-secure startup handler
will be made

() Non-secure Project
* RA device project for TrustZone non-secure execution
+ All code, data and peripherals placed in this project will
be initialized as non-secure
* Must be associated with a secure project or secure bundle
+ Non-secure startup handler will be called after secure
code initialization

@ < Back

Figure 12: Flat, Secure, or Non-Secure Project

Cancel

For more information on Arm® TrustZone®, see Primer: ARM® TrustZone® Project Development.

2.2.4.4 Selecting a Project Template

In the next window, select the buiild artifact and RTOS.
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Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Build Artifact and RTOS Selection

Build Artifact Selection
@ Executable
* Project builds to an executable file
(O Static Library
+ Project builds to a static library file
() Executable Using an RA Static Library
* Project builds to an executable file
* Project uses an existing RA static library project

)
@

< Back

RTOS Selection
No RTOS

Cancel

Figure 13: RA MCU Project Generator (Screen 3)

In the next window, select a project template from the list of available templates. By default, this

screen shows the templates that are included in your current RA MCU pack. Once you have selected
the appropriate template, click Finish.

Note

If you want to devel op your own application, select the basic template for your board, Bare Metal - Minimal.
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Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Template Selection

Project Template Selection

O () Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks,
and the C runtime environment.

C) | Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

@ < Back Next = Cancel
Figure 14: RA MCU Project Generator (Screen 4)

When the project is created, e2 studio displays a summary of the current project configuration in the
RA MCU Project Editor.

& [MyProject] FSP Configuration 2

Summary Generate Project Content
Project Summary
RENESAS
Board: EK-RABM3
Device: R7FABM3AH3CFC
Tooelchain: GCC ARM Embedded
Tooelchain Version:
FSP Version:

Selected software components

Arm CMSIS Version 5 - Core (M)

RAGM3-EK Board Support Files

Board support package for RTFAGM3AH3CFC
Board support package for RAGM3

Board support package for RAGM3 - FSP Data

Board Support Package Common Files
1/O Port

|5ummary BSP| Clocks Pins| Interrupts Event Links| Stacks Componentsl

Figure 15: RA MCU Project Editor and available editor tabs
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On the bottom of the RA MCU Project Editor view, you can find the tabs for configuring multiple
aspects of your project:

e With the Summary tab, you can see all they key characteristics of the project: board,
device, toolchain, and more.

e With the BSP tab, you can change board specific parameters from the initial project
selection.

e With the Clocks tab, you can configure the MCU clock settings for your project.

e With the Pins tab, you can configure the electrical characteristics and functions of each
port pin.

e With the Interrupts tab, you can add new user events/interrupts.

* With the Event Links tab, you can configure events used by the Event Link Controller.

e With the Stacks tab, you can add and configure FSP modules. For each module selected in
this tab, the Properties window provides access to the configuration parameters, interrupt
priorities, and pin selections.

e The Components tab provides an overview of the selected modules. Although you can also
add drivers for specific FSP releases and application sample code here, this tab is normally
only used for reference.

The functions and use of each of these tabs is explained in detail in the next section.

2.2.5 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the
RA Configuration editor window. Importantly, the initial configuration of the MCU after reset and
before any user code is executed is set by the configuration settings in the BSP, Clocks and Pins
tabs. When you select a project template during project creation, e2 studio configures default values
that are appropriate for the associated board. You can change those default values as needed. The
following sections detail the process of configuring each of the project elements for each of the
associated tabs.

2.2.5.1 Summary Tab
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= 0

Summary

Project Summary

Board: EK-RABM3

Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version:

FSP Version:

Project Type: Flat

Selected software components

Simple application that blinks an LED. No RTOS
included.

Board Support Package Common Files

1/0 Port

Arm CMSIS Version 5 - Core (M)

Board support package for RTFAGM3AH3CFC
Board support package for RABIM3

Board support package for RABIM3 - FSP Data
RABM3-EK Board Support Files

o|: 4

Summary| BSP | Clocks| Pins | Interrupts | Event Links | Stacks| Components

()]

Generate Project Content

RENESAS

Figure 16: Configuration Summary tab

The Summary tab, seen in the above figure, identifies all the key elements and components of a
project. It shows the target board, the device, toolchain and FSP version. Additionally, it provides a
list of all the selected software components and modules used by the project. This is a more

convenient summary view when compared to the Components tab.

The summary tab also includes handy icons with links to the Renesas YouTube channel, the Renesas
support page and to the RA FSP User Manual that was downloaded during the installation process.

2.2.5.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in

the lower left of the Project Configurations view as shown below.

Note

If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.
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Property
~ R7FABM3AHICFC

part_number
rom_size_bytes
ram_size_bytes
data_flash_size_bytes
package_style
package_pins

~ RABM3

series

~ RABM3 Family

OFS0 register settings
OFS1 register settings
MPU

~ RA Common

Main stack size (bytes)
Heap size (bytes)
MCU Vee (mV)

Darammetar charlbinm

Summa locks | Pins | Interrupts | Event Links | Stacks  Components

Value

R7FAEM3AH3CFC
2097152

655360

65536

LOFP

176

&

0400
0
3300

Niczhlad

Figure 17: Configuration BSP tab

=3

The Properties view shows the configurable options available for the BSP. These can be changed
as required. The BSP is the FSP layer above the MCU hardware. e2 studio checks the entry fields to
flag invalid entries. For example, only valid numeric values can be entered for the stack size.

When you click the Generate Project Content button, the BSP configuration contents are written

to ra_cfg/fsp_cfg/bsp/bsp_cfg.h

This file is created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is

clicked.

2.2.5.3 Configuring Clocks

The Clocks tab presents a graphical view of the MCU's clock tree, allowing the various clock dividers
and sources to be modified. If a clock setting is invalid, the offending clock value is highlighted in

red. It is still possible to generate code with this setting, but correct operation cannot be guaranteed.
In the figure below, the USB clock UCLK has been changed so the resulting clock frequency is 60 MHz
instead of the required 48 MHz. This parameter is colored red.
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& *[MyProject] FSP Configuration &3 =8
(¥}

Clocks Conflguratlon Generate Project Content

EZ Restore Defaults

XTAL 24MHz }\L  ICLK Div /2 v ] ICLK 120MHz \
PLL Src: XTAL v > PCLKA Div /2 || PCLKA 120MHz \
b
PLL Div /2 v > PCLKB Div /4 ~ || PCLKB 60MHz \
b
PLL Mul x20.0 v > PCLKC Div /4 v | PCLKC 60MHz \
b
| USBMCLK 24MHz | | [PLL240MHz |-/ Clock Src: PLL <> PCLKD Div /2 || PCLKD 120MHz \
HOCO 20MHz v SDCLKout On |/ SDCLKout 120MHz \
i
| LOCO 32768Hz | > BCLK Div /2 + [ BCLK 120MHz \
)
| MOCO 8MHz | BCLK/2 || BCLKout 60MHz \
| SUBCLK 32768Hz | " v ucceomz \
\> FCLK Div /4 v [ FCLK 60MHz \
CLKOUT Disabled > CLKOUT Div /1 || CLKOUT 0Hz \

Summary | BS ins Interrupts| Event Links | Stacks| Components

Figure 18: Configuration Clocks tab

When you click the Generate Project Content button, the clock configuration contents are written
to: ra_gen/bsp_clock_cfg.h

This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

2.2.5.4 Configuring Pins

The Pins tab provides flexible configuration of the MCU's pins. As many pins are able to provide
multiple functions, they can be configured on a peripheral basis. For example, selecting a serial
channel via the SCI peripheral offers multiple options for the location of the receive and transmit pins
for that module and channel. Once a pin is configured, it is shown as green in the Package view.

Note

If the Package view window is not open in €2 studio, select Window > Show View > Pin Configurator > Package
from the top menu bar to openit.

The Pins tab simplifies the configuration of large packages with highly multiplexed pins by
highlighting errors and presenting the options for each pin or for each peripheral. If you selected a
project template for a specific board such as the EK-RA6M3, some peripherals connected on the
board are preselected.
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& *[MyProject] FSP Configuration 2 =78

& Package 2 G v|@-M~y=08
. = B [+] i
Pins Cunflguratlun Generate Project Content
Select pin configuration s~ &)
RA6M3-EK pincfg 5 Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration

type filter text

Analog:DAC12 ~ Module name: SCI7 fo
Connectivity:CAN Usage: ‘When using Simple 12C mode, ensure 5 _
v Connectivity:ETHERC type is n-ch open drain, RrF‘:i!:i:Fx:ch
~ Connectivity:lIC When switching between I12C and otf (Top View)
~ v Connectivity:SCI disable.
scio Pin Group Selection: _Conly ~
scn
sci2 Operation Mode: Asynchronous UART L
v 5CI3 Input/Output
sCi4 P612
scis oc
5Cl6 v |P614 o
i SGIy v < 5%

Summary |BSP| & Cloc iterrupts | Event Links| Stacks | Components

v
[% Pin Conflicts & es v &= O
€rrors, U warnings, 0 others

Figure 19: Pins Configuration

The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another
peripheral or I/O function the pin will be shown as red in the package view and also with white cross
in a red square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. The
Pin Conflicts view provides a list of conflicts, so conflicts can be quickly identified and fixed.

In the example shown below, port P611 is already used by the CAC, and the attempt to connect this
port to the Serial Communications Interface (SCI) results in a dangling connection error. To fix this

error, select another port from the pin drop-down list or disable the CAC in the Pin Selection pane
on the left side of the tab.

% *[MyProject] FSP Configuration 2 = 8
Pins Configuration e
9 Generate Project Content
Select pin configuration e v &l
RABM3-EK.pincfg e Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration
AnalogL Hin Group Selection: _Conly v Py
Connecti Operation Mode: Simple SPI ~
~ Connecti Input/Output
nput/Outpu
v Connecti P P
~ B Connecti v [P613 e d
SClo v |P614 =
s
. =
sci2 v [P612
v SCi3 CTS RIS S5: o ECI =
SCl4 N
<Cl5 None
sc6 ., None %
< > < >
Summary |BSP | & Clocks| @ Pins| Interrupts| Event Links | Stacks| Components
Figure 20: e2 studio Pin configurator
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The pin configurator also shows a package view and the selected electrical or functional
characteristics of each pin.

& Package 3% ;}{vlg‘vv'ﬂg

Connection Status
Drive Capacity
~ Mode

Qutput Type
Pull Up

RTFABM3AxaFC
176LOFP

(Top View)

Figure 21: e2 studio Pin configurator package view

When you click the Generate Project Content button, the pin configuration contents are written
to: ra_gen\bsp_pin_cfg.h

This file will be created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

To make it easy to share pinning information for your project, e2 studio exports your pin
configuration settings to a csv format and copies the csv file to ra_gen/<MCU package>.csv.

2.2.5.5 Configuring Interrupts from the Stacks Tab

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt
priority. Select the driver in the Stacks pane to view and edit its properties.
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Creating Interrupts from the Interrupts Tab

% [MyProject] FSP Configuration &3

Stacks Configuration

Threads

~ &¢ HAL/Common

= HAL/Common Stacks

=0
(]

Generate Project Content

4] New Stack > == Extend Stack > %] Remove

ort I/0 Port
ron r_ioport

& g_elc ELC Driver on
r_elc

®

& g_uart0 UART Driver on r_sci_uart

®

4 g_ioport 10 Port Driver on r_ioport
4 g_elc ELC Driver on r_elc
@ g_uart0 UART Driver on r_sci_uart
Objects
<

Summary |BSP | & Clocks| @ Pins |Interrupts | Event Links | Stacks| Components

[ Properties % . Problems @& Smart Browser

g_uart0 UART Driver on r _sci_uart

Property
Common

Settings
APl Info

~ Module g_uart0 UART Driver on r_sci_uart
General

Baud

Flow Control

Extra

~ Interrupts
Callback

T

& g_transfer? Transfer
Driver on r_dtc SCI0
RXI (Receive data full)

& g_transferQ Transfer
Driver on r_dtc SCI0
TXI (Transmit data

® empty) ®

Value

user_uart_callback

Receive Interrupt Priority

Transmit Data Empty Interrupt Priority
Transmit End Interrupt Priority

Error Interrupt Priority

Priority 12
Priority 12
Priority 12
Priority 12

v Pins

Figure 22: Configuring Interrupts in the Stacks tab

On the Interrupts tab, the user can bypass a peripheral interrupt set by the FSP by setting a user-
defined ISR. This can be done by adding a new event via the New User Event button.

¢ [MyProject] FSP Configuration 2

User Events

Interrupts Configuration

(]

Generate Project Content

%] New User Event >

Event ISR
Allocations

Interrupt  Event ISR

0 SCI0 RXI (Receive data full) sci_uart_ri_isr

1 SCI0 TXI (Transmit data empty) sci_uart_txi_isr

2 SCI0 TEI (Transmit end) sci_uart_tei_isr

3 SCI0 ERI (Receive error) sci_uart_eri_isr

Summary |[BSP | & Clocks | @ Pinvent Links| Stacks | Components
Figure 23: Configuring interrupt in Interrupt Tab
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% [MyPraject] FSP Configuration &3

Interrupts Configuration

User Events

1. & New!

Event

ISR

Allocations

Interrupt
0

1
2
3

Event

SCI0 RXI (Receive data full)
SCI0 TXI (Transmit data empty)
SCI0 TEI (Transmit end)

SCI0 ERI (Receive error)

ISR

sci_uart_rxi_i
sci_uart_txi_i
sci_uart_tei_i
sci_uart_eri_i

Summary |BSP | & Clocks| @ Pins | Interrupts| Event Links | Stacks| Components

[ Properties & Problems Smart Browse

Properties are not available.

ADC
AGT
CAC
CAN
CGC
COMP
CTSU
DMAC
DoC
DRW
DTC
EDMAC
ELC
EPTPC
FCU
GLCDC
GPT
ICU

IiC
IOPORT
IWDT
JPEG
KEY
LPM
VD
0oPS
PDC
POEG
QsPI
RTC
SCE

>

>

> F & Package 2

R7FAGM3AxoxxFC
176LQFP

SCl

>|| 3. 5Ci0

> || 4 SCI0 RXI (Receive data full)
>

Enter the name of ISR for the new user event.

E MNew User Event

SDHIMMC
SPI

SRC

Sl

USBFS
USBHS

Enter the name of the ISR for the new user event:

> S
> SCI2
> SCI3
> SCl4
> SCI5
> SCle

SCIO TXT (Transmit data empty)

SCIO TEI (Transmit end)

SCI0 ERI (Receive error)

SCI0 AM (Address match event)

SCI0 RXI OR ERI (Receive data full/Receive)

Figure 24: Adding user-defined event

| user_defined__sci_uart_rd_i srl

Cancel

Figure 25: User-defined event ISR
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& *[MyProject] FSP Configuration 2 - =
2 ) [¥]
Interrupts Configuration Generate Project Content
User Events #] New User Event > &
Event ISR
SCI0 RXI (Receive data full) user_defined__sci_uart_rxi_isr
Allocations
Interrupt  Event ISR
0 SCI0 RXI (Receive data full) user_defined__sci_uart_rxi_isr
1 SCI0 TXI (Transmit data empty) sci_uart_txi_isr
2 SCIO TEI (Transmit end) sci_uart_tei_isr
3 SCIO ERI (Receive errar) sci_uart_eri_isr

Summary |[BSP | & Clocks @ Pins | Interrupts| Event Links Stacks| Components

Figure 26: Using a user-defined event

2.2.5.6 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by
peripheral to make it easy to find and verify them.

% *[MyProject] FSP Configuration 2 =8
. . . o
Event Links Configuration Generate Project Content
User Events Produced | New User Event > %1 Remove  User Events Consumed | New User Event
Event Peripheral Function Event
GPTO CAPTURE COMPARE A (Compare match A) PORT 1 GPTO CAPTURE COMPARE A (Compare match A)
Allocations /
Peripheral Function / Event (3
DAC12 Channel 0 No allocation
DAC12 Channel 1 No allocation
PORT 1 GPTO CAPTURE COMPARE A (Compare match A)
PORT O allocation v

Summary BSP | Clocks |Pins | Interrupts |Event Links | Stacks| Components

Figure 27: Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can
be defined by clicking the relevant New User Event button. Once a consumer is linked to a
producer the link will appear in the Allocations section at the bottom.

Note

When selecting an ELC event to receive for a module (or when manually defining an event link), only the events
that are made available by the modules configured in the project will be shown.

2.2.6 Adding Threads and Drivers

Every RTOS-based RA Project includes at least one RTOS Thread and a stack of FSP modules running
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in that thread. The Stacks tab is a graphical user interface which helps you to add the right modules
to a thread and configure the properties of both the threads and the modules associated with each
thread. Once you have configured the thread, e2 studio automatically generates the code reflecting
your configuration choices.

For any driver, or, more generally, any module that you add to a thread, e2 studio automatically
resolves all dependencies with other modules and creates the appropriate stack. This stack is
displayed in the Stacks pane, which e2 studio populates with the selected modules and module
options for the selected thread.

The default view of the Stacks tab includes a Common Thread called HAL/Common. This thread
includes the driver for 1/O control (IOPORT). The default stack is shown in the HAL/Common Stacks
pane. The default modules added to the HAL/Common driver are special in that the FSP only requires
a single instance of each, which e2 studio then includes in every user-defined thread by default.

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread
becomes the default location where you can add additional drivers to your application.

For a detailed description on how to add and configure modules and stacks, see the following
sections:

e Adding and Configuring HAL Drivers
e Adding Drivers to a Thread and Configuring the Drivers

Once you have added a module either to HAL/Common or to a new thread, you can access the
driver's configuration options in the Properties view. If you added thread objects, you can access
the objects configuration options in the Properties view in the same way.
You can find details about how to configure threads here: Configuring Threads
Note
Driver and module selections and configuration options are defined in the FSP pack and can therefore change
when the FSP version changes.

2.2.6.1 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your
application using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to
HAL/Common Stacks.
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& “[MyProject] FSP Configuration £ = b
Click here to add )
Stacks Configuration
g new module Generate Project Content
Threads = HAL/Common Stacks ] New Stack » %] Remove
~ ¥ HAL/Common p p ;
= o U’_ ) A & g_ioport I/O Port & g_wdt0 Watchdog & g_cgc0 CGC Driver on
4 g_ioport 1/O Port Driver on r_ioport . . ;
i Driver on r_ioport Driver on r_wdt r_cgc
& g_wdt0 Watchdog Driver on r_wdt
4 g_cgc0 CGC Driver on r_cgc 6] 6] 6]

Objects

Summary | BSP | Clocks  Pins | Interrupts Ewvent Linblf Stacks domponents

Figure 28: e2 studio Project configurator - Adding drivers
2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.

3. Select a driver from the menu New Stack > Driver.

&1 New S1 Analog
Artificial Intelligence
Audio
Bootloader
CapTouch
Connectivity
DSP
Graphics
Input
Monitaring
Motor
Networking
Power
Security
Sensor

_— Storage
Conflicts & |G 2

| System
E Timers Port Output Enable for GPT (r_poeg)
Realtime Clock (r_rtc)

Three-Phase PWM (r_gpt_three_phase)
Timer, General PWM (r_gpt)

Timer, Low-Power (r_agt)

iption

B N e

¢ e ed

Transfer

4" Search...

Figure 29: Select a driver
4. Select the driver module in the HAL/Common Modules pane and configure the driver
properties in the Properties view.
e2 studio adds the following files when you click the Generate Project Content button:
e The selected driver module and its files to the ra/fsp directory

e The main() function and configuration structures and header files for your application as
shown in the table below.
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File

Contents

Overwritten by Generate
Project Content?

ra_gen/main.c

Contains main() calling
generated and user code. When
called, the BSP already has
Initialized the MCU.

Yes

ra_gen/hal_data.c

Configuration structures for HAL
Driver only modules.

Yes

ra_gen/hal_data.h

Header file for HAL driver only
modules.

Yes

src/hal_entry.c

User entry point for HAL Driver
only code. Add your code here.

No

The configuration header files for all included modules are created or overwritten in this folder:

ra_cfg/fsp_cfg

2.2.6.2 Adding Drivers to a Thread and Configuring the Drivers

For an application that uses the RTOS, you can add one or more threads, and for each thread at least
one module that runs in the thread. You can select modules from the Driver dropdown menu. To add
modules to a thread, follow these steps:

1. In the Threads pane, click New Thread to add a Thread.
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£ *[MyProject] FSP Configuration % =
. . o
Stacks conﬁguratlon Generate Project Content
Threads | ¢|New Thread fi|Remove =  New Thread Stacks %] New Stack >
w & HAL/Common . Add stacks to the selected thread by using the ‘New Stack =" toolbar button (above), or by

# g ioport I/O Port (r_ioport) Y pasting here from the clipboard.
% New Thread

< >

Objects 4| New Object >

Summary | BSP |Clocks |Pins | Interrupts | Event Links | Stacks| Components

[ Properties & =
New Thread
Settings  Property Enter Name of your
Parformance thread here. Example:
RA My Thread
Interrupts
w Thread
Symbol new threa
Name New Thread
Stack size (bytes) 024
Priority 1
Auto start Enabled

Tirna clicinm intanal Hiebe

Figure 30: Adding a new RTOS Thread on the Stacks tab

2. In the Properties view, click on the Name and Symbol entries and enter a distinctive
name and symbol for the new thread.

Note
€2 studio updates the name of the thread stacks pane to My Thread Stacks.

3. In the My Thread Stacks pane, click on New Stack to see a list of modules and drivers.
HAL-level drivers can be added here.
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5 Stacks Conﬁguration Generate Pr?ject Content
®
g; Threads %] New Thread =|Remove |-| My Thread Stacks & New S - Analog N
w & HAL/Common '0 Add stacks to the selected thread by using the ‘New Stack >’ toolbz Artificial Intelligence > B
4 g_ioport I/O Port (r_ioport) ¥  from the clipboard. Audio 5
My Thread Bootloader >
CapTouch >
#  Azure RTOS USBX HCDC Connectivity >
4 Azure RTOS USBX HHID DSP >
< & & Azure RTOS USBX PAUD Graphics 5
5 : 5 & Azure RTOS USBX PCDC Input 5
TLRES £ New Object > 4 Azure RTOS USBX PHID Monitort s
4 Azure RTOS USBX PMSC Mz:;rorlng 3
@ CAN (r_can) i
% |2C Communication Device (rm_comms_i2c) :]etworklng :
p = wer
Summary |BSP | Clocks |Pins |Interrupts | Event Links | Stacks| Components i :;E ::2: g::([i'_[i;i;teo RTOS >
[ Properties 2 & 12C Shared Bus (rm_comms_i2c) Security > F B
& 12C Slave (r_iic_slave) Sensor >
Ss LD & 125 (r_ssi) Storage > In
Settings Froperty Value @ SPI (r_sci_spi) System >
Performance 4 SPI(r_spi) Timers N
RA % UART (r_sci_uart) TersrT 5
Interrupts % USB Composite (r_usb_composite) g .
« Thread @ USB HCDC (r_usb_hcdc) L carc
Symbol new thread0 & USB HHID (r_usb_hhid)
Name My Thread “  USB HMSC (r_usb_hmsc)
Crark cive fhutac) 14 # USB Host Vendor class {r_usb_hvnd)
< 4 USB PCDC (r_usb_pcdc) >
& USB PHID (r_usb_phid)
& USB PMSC (r_usb_pmsc)
- M % USB Peripheral Vendor class (r_usb_pvnd)

Figure 31: Adding Modules and Drivers to a thread
4. Select a module or driver from the list.

5. Click on the added driver and configure the driver as required by the application by
updating the configuration parameters in the Properties view. To see the selected module
or driver and be able to edit its properties, make sure the Thread containing the driver is
highlighted in the Threads pane.

R11UMO155EU0280 Revision 2.80 RENESANS Page 38/ 4,257
Jun.27.2022



Flexible Software Package User’s Manual

Starting Development > e2 studio User Guide > Adding Threads and Drivers > Adding Drivers to a Thread and Configuring the Drivers

8 *[MyProject] FSP Configuration &
[V}

Stacks Configuration Generate Project Content

Threads 4] New Thread #| Remove = g_wdt0 Watchdog Driver on r_wdt Stacks 4| New Stack >

~ &t HAL/Commaon

& g_ioport I/O Port Driver on r_ioport
~ & New Thread

“# g_wdt0 Watchdog Driver on r_wdt ®

# g_wdt0 Watchdog
Driver on r_wdt

Objects #] New Object >

Summary BSP Clocks |Pins Interrupts Event Links | Stacks| Components
[ Properties 2 [T Problems @ Smart Browser

g_wdt0 Watchdog Driver on r_wdt

Settings Property Value
APl Info Common
v Module g_wdt0 Watchdog Driver on r_wdt
Name g_wdt0
Timeout 16,384 Cycles
Clock Division Ratio PCLK/8192
Window Start Position 100% (Window Position Not Specified)
‘Window End Position 0% (Window Position Not Specified)
Reset Control Reset Output
Stop Control WODT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 32: Configuring Module or Driver properties

6. If needed, add another thread by clicking New Thread in the Threads pane.

When you press the Generate Project Content button for the example above, e2 studio creates
the files as shown in the following table:

File Contents Overwritten by Generate
Project Content?

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called the BSP will have
initialized the MCU.

ra_gen/my_thread.c Generated thread "my_thread" |Yes
and configuration structures for
modules added to this thread.

ra_gen/my_thread.h Header file for thread Yes
"my_thread"

ra_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

ra_gen/hal_data.h Header file for HAL Driver only |Yes
modules.

src/hal_entry.c User entry point for HAL Driver | No

only code. Add your code here.
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src/my_thread_entry.c User entry point for thread No
"my_thread". Add your code
here.

The configuration header files for all included modules and drivers are created or overwritten in the
following folders: ra_cfg/fsp_cfg/<header files>

2.2.6.3 Configuring Threads

If the application uses an RTOS, the Stacks tab can be used to simplify the creation of RTOS
threads, semaphores, mutexes, and event flags.

The components of each thread can be configured from the Properties view as shown below.

1 Properties 2
New Thread

Settings Property Value
v Common
General
Hooks
Stats
Memory Allocation
Timers
Optional Functions

RA
Logging

w Thread
Symbol new_thread0
Name New Thread
Stack size (bytes) 1024
Priority 1
Thread Context NULL
Memaory Allocation Static

Figure 33: New Thread Properties

The Properties view contains settings common for all Threads (Common) and settings for this
particular thread (Thread).

For this thread instance, the thread's name and properties (such as priority level or stack size) can
be easily configured. e2 studio checks that the entries in the property field are valid. For example, it
will verify that the field Priority, which requires an integer value, only contains numeric values
between 0 and 9.

To add RTOS resources to a Thread, select a thread and click on New Object in the Thread Objects
pane. The pane takes on the name of the selected thread, in this case My Thread Objects.
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.
8 ©F *[MyProject] FSP Configuration X ==

= = G
Stacks Configuration Generate Project Content

e

Threads %| New Thread =|Remove |- 4| New Stack =
My Thread Stacks

£ wmif

v & HAL/Common

4 g_ioport I/ Port {r_ioport) 2
~ & My Thread (g,wgg] Watchdog
r_wi

# g_wdt0 Watchdog (r_wdt)
@

1 New Ot @ %/ent Flags
Event Flags utex

® Queue
@® Semaphore

Summary |BSP | Clocks | Pins |Interrupts | Event Links | Stacks| Components

T Properties i =0
g_new_queuel Queue
Settings Property Value

MName Mew OQuele

Symbol g_new_queuel

WIC33ayt .Ji CAVVUTUS) 1

Queue Size (Bytes) 20

< >

vﬁ‘

Figure 34: Configuring Thread Object Properties

Make sure to give each thread object a uniqgue name and symbol by updating the Name and
Symbol entries in the Properties view.

2.2.7 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or
excluded. Modules common to all RA MCU projects are preselected (for example: BSP > BSP >
Board-specific BSP and HAL Drivers > all > r_cgc). All modules that are necessary for the
modules selected in the Stacks tab are included automatically. You can include or exclude
additional modules by ticking the box next to the required component.
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& *[MyProject] FSP Configuration 52 = 0
Components Configuration Generate ;?m Content
Filter | Al v
Component Version Description Variant 2
~ ¥ rabm3
device Board support package for R7TFABM3AH3CFC R7FAGM3AHS..
device Board support package for RAGM3
I device Board support package for RTFABM3AF2CBG R7FABM3AF2C...
O device Board support package for R7TFABM3AF2CLK R7FABM3AF2C...
O device Board support package for RTFAGM3AF3CFB R7FAGM3AF3C...
I device Board support package for RTFABM3AF3CFC R7FABM3AF3C...
O device Board support package for RTFABM3AF3CFP R7FAGM3AF3C...
O device Board support package for RTFAGM3AH2CBG R7FAGM3AH2..
I device Board support package for RTFABM3AH2CLK R7FA6M3AHZ...
O device Board support package for R7TFAGM3AH3CFB R7FAGM3AHS..
O device Board support package for RTFAGM3AH3CFP R7FAGM3AHS..
fsp Board support package for RA6M3 - FSP Data
¥ rabm4
¥ rabm5
¥ rabtl
% c_sdk
~ #% CMSIS
v # CMSIS5
CoreM 57.0 Arm CMSIS Version 5 - Core (M)
O coreM 5.6.0 Arm CMSIS Version 5 - Core (M)
[ psp 5.6.0 Arm DSP Library Source
O pse 5.7.0 Arm DSP Library Source
O NN 5.6.0 Arm NN Library Source v

Summary | BSP | Clocks | Pins |Interrupts | Event Links Stac

Figure 35: Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected
component into the following folders:

* ra/fsp/inc/api

e ra/fsp/inc/instances

e ra/fsp/src/bsp

e ra/fsp/src/<Driver Name>

e2 studio also creates configuration files in the ra_cfg/fsp_cfg folder with configuration options set in
the Stacks tab.

2.2.8 Writing the Application

Once you have added Modules and drivers and set their configuration parameters in the Stacks tab,
you can add the application code that calls the Modules and drivers.

Note
To check your configuration, build the project once without errors before adding any of your own application code.

2.2.8.1 Coding Features

e2 studio provides several efficiency improving features that help write code. Review these features
prior to digging into the code development step-by-step sections that follow.

Autocomplete

Autocomplete is a context aware coding accelerator that suggests possible completions for partially
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typed-in code elements. If you can 'guess' the first part of a macro, for example, the Autocomplete
function can suggest options for completing the rest of the macro.

In the following example, a macro related to a BSP_IO setting needs to be found. After typing
BSP_IO_in a source code file, pressing Ctrl + Space opens the Autocomplete list. This list shows a
selection of context aware options for completing the macro. Scroll through the window to find the
desired macro (in this case BSP_IO_LEVEL_HIGH) and click on it to add it to your code.

Protect PFS registers

R_BSP_PinAccessDi;able( );

ogegle level for next rite

if (BSP_IO_LEVEL_LOW == pin_level)

{ pin_level = BSP_IO0_
i lse o BSP_IO_DIRECTION_INPUT ~
{ o BSP_IO_DIRECTION_OUTPUT
pin_level = BSP_ IO L o o
} o BSP_IO_LEVEL_LOW
vTaskDelay(configTICK_RA ° BSP_IO_PORT_00
} o BSP_IO_PORT_00_PIN_00
} o BSP_IO_PORT_00_PIN_01
. o BSP_IO_PORT_00_PIN_02 R v
o BSP_IO_PORT_00_PIN_03
E = r# o BSP_IO_PORT_00_PIN_04
o BSP_IO_PORT_00_PIN_05
o BSP 10 PORT 00 PIN 06 vi Moc

Press ‘Ctrl+Space’ to show Template Proposals

Figure 36: Autocomplete example

Other code elements can use autocomplete too. Some of the more common uses for Autocomplete
include Enumerations, Types, and API functions - but try it in any situation you think the tool may
have enough context to determine what you might be looking for.

For a hands-on experience using Autocomplete use the Quick FSP Labs for Creating Blinky from
Scratch and Creating an RTC Blinky from Scratch. These 15-minute Do it Yourself labs take you
through the step-by-step process of using Autocomplete, Developer Assistance, and the Help
system.

Welcome Window
The e2 studio Welcome window displays useful information and common links to assist in

development. Check out these resources to see what is available. They are updated with each
release, so check back to see what has been added after a new release.

R11UMO155EU0280 Revision 2.80 RENESANS Page 43/ 4,257
Jun.27.2022

User’s Manual


https://en-support.renesas.com/knowledgeBase/19110690
https://en-support.renesas.com/knowledgeBase/19110690
https://en-support.renesas.com/knowledgeBase/19110690

Flexible Software Package

Starting Development > e2 studio User Guide > Writing the Application > Coding Features

User’s Manual

Q workspace - MyProject/configurationxml - e* studio

File Edit MNavigate Search Project RenesasViews Run Window Help

[ D Welcome

tr s AaE==

i)
| e ;
] Welcome to e2 studio
&
&
Create a new e2 studio C/C++ project Get an overview of the features
Import existing e2 studio projects from the Go through tutorials
filesystem or archive
Try out the samples
Download and import sample projects from v b
Renesas website
Find out what is new
Review the IDE's most fiercely contested
preferences
Quickly getting familiar with the tool
Open a file from the filesystem
Always show Welcome at start up

Cheat Sheets

Figure 37: Welcome window

Cheat sheets are macro driven illustrations of some common tasks. They show, step-by-step, what
commands and menus are used. These will be populated with more examples on each release.
Cheat Sheets are available from the Help menu.

views Run Window

= myProjectRTOS

Project] FSP Configurat
#incluc

FSP_CPE
void R_
FSP_CPI

® * mair
“void h:

Help
) Welcome
(@ Help Contents
%' Search
Show Contextual Help

Show Active Keybindings...
Cheat Sheets...

Renesas Help

CMSIS Packs Management
# Add Renesas Toolchains
%8 Perform Setup Tasks..

{ * % Check for Updates
@ Install New Software...
- #if BSI i& AR Embedded Workbench plugin manager...
/* @ About e? studio

Ctrl+Shift+L

5 use

R_BSP_NGNSECUrEERTEr();

Figure 38: Cheat Sheets
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Developer Assistance

FSP Developer Assistance provides developers with module and Application Programming Interface
(API) reference documentation in e2 studio. After configuring the threads and software stacks for an
FSP project with the RA Configuration editor, Developer Assistance quickly helps you get started
writing C/C++ application code for the project using the configured stack modules.

1. Expand the project explorer to view Developer Assistance

2

Iy Project Explorer &3 -

v 15 Blinky
! Includes

JoU

 ra
(2 ra_gen
2 src
(= ra_cfg
(= script
|| Blinky Debug.launch
% configuration.xml
2 RTFABM3AH3CFC.pincfg
| ra_cfg.bd
RASM3I-EK pincfg

v (2) Developer Assistance
v g HAL/Common
4 g_ioport I/O Port Driver on r_ioport
42 g_elc ELC Driver on r_elc
@ g_adc0 ADC Driver on r_adc

Figure 39: Developer Assistance

2. Expand a stack module to show its APIs

w () Developer Assistance
v gt HAL/Common
42 g_joport |70 Port Driver on r_ioport
47 g_elc ELC Driver on r_elc
w & g_adch ADC Driver on r_adc

~ @ fsp_err t R_ADC_Open(adc_ctrl_t *p_ctrl, ade_cfg_t const *const p_cfg)
B3 CallR_ADC_Open()

v @ fsp_err t R_ADC ScanCfg(ade_ctrl_t *p_ctrl, adc_channel_cfg_t const *const p_channel_cfg)
|25 CallR_ADC ScanCfg()

v @ fsp_err t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
£ Call R_ADC_InfoGet()

v @ fsp_err_t R_ADC ScanStart(adc_ctrl_t *p_ctrl)
|24 Call R_ADC_ScanStart()

v @ fsp_err_t R_ADC_ScanStop(adc_ctrl_t *p_ctrl}
B4 Call R_LADC ScanStop()

v @ fsp_err t R_ADC StatusGet{adc_ctrl_t *p_ctrl, ade_status_t *p_status)
[ Call R_ADC_StatusGet()

~ @ fsp_err t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_channel_t const reg_id, uint16_t *const p_data)
£ Call R_ADC_Read()

w @ fon err tRADC Read?2(ade ctrl t*n ctrl ade channel t const rea id uint3? t*const n datal ¥
>

Figure 40: Developer Assistance APIs
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3. Dragging and dropping an API from Develop Assistance to a source file helps to write source
code quickly.

I Project Explorer 2 =5 W § = B g [MyProject] FSP Configuration [€) *hal_entry.c 52
~ (@ Developer Assistance #include "hal_data.h"
~ &% HAL/Common
& g_ioport I/O Port Driver on r_ioport
~ # g_adc0 ADC Driver on r_adc
fep et RACCOpemet_ctrl_t *p_ctrl, adc_cfg_t
E=2 Call R_ADC_Open()

FSP_CPP_HEADER
void R_BSP_WarmStart(bsp warm_start_event_t event);
FSP_CPP_FODTER

® * main() is generated by the RA Configuration editor and is used to generate threads if an
“void hal_entry(void) {

%

- T VI N

eIt — adc_ctrl_t *p_cCtMewaig co
@ fsp_err_t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_infc
@ fsp_err_t R_ADC ScanStart(adc_ctrl_t *p_ctrl)

add vour own code here *

| = R_ADC_Open(&g_adc®_ctrl, &g_adc@_cfg);

@ fsp_err_t R_ADC_ScanStop(adc_ctrl_t *p_ctrl) 14 -
@ fsp_err_t R_ADC_StatusGet(adc_ctri_t *p_ctrl, adc_st L -t (1 SIEClile [y
- = == B = 16 /* Enter non-secure code */
@ fsp_err_t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_chann 17 R_BSP_NonSecureEnter();
® fsp_err_t R_ADC_Read32(adc_ctrl_t *p_ctrl, adc_cha 18 #endif
@ fsp_err_t R_ADC_SampleStateCountSet{adc_ctrl_t * 19 }
@ fsp_err_t R_ADC Close(adc_ctrl_t *p_ctrl) 20
@ fsp_err_t R_ADC_OffsetSet(adc_ctrl_t *const p_ctrl, | %E ® *.Lh;SB;:nGtiogtistizlled at v:r‘iius points dur‘ir;g{the startup process. This implementatic
. N 27 “void R_BSP_WarmStart(bsp warm start event t even
@ fsp_err_t R_ADC_Calibrate(adc_ctrl_t *const p_ctrl, v v . - if (BSP WARM START RESET —— event) £

Figure 41: Dragging and Dropping an API in Developer Assistance

For a hands-on experience using Developer Assistance use the Quick FSP Labs for An Introduction to
Developer Assistance, Creating Blinky from Scratch and Creating an RTC Blinky from Scratch. These
15-minute Do it Yourself labs take you through the step-by-step process of using Autocomplete,
Developer Assistance, and the Help system.

Information Icon
Information icons are available on each module in the thread stack. Clicking on these icons opens a

module folder on GitHub that contains additional information on the module. An example information
Icon is shown below:

47 g_ioport 1/0 Port

\ Driver on r_ioport
2

Figure 42: Information icon

IDE Help

A good source of additional information for many FSP topics is the Help system. To get to the Help
system, click on Help and then select Help Contents as seen below.
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n Window Help

. Welcome #
% [Blinky] ¢ Help Contents
Stacks Show Contextual Help
Show Active Keybindings... Ctrl+Shift+L
Threads Cheat Sheets...
v & He Renesas Help >
& CMSIS Packs Management >
#® # Add Renesas Toolchains
® 4% perform Setup Tasks...
% Check for Updates
@ Install New Software...
i& AR Embedded Workbench plugin manager...
@ About e? studio

Figure 43: Opening the Help System

Once the Help system is open, select the RA Contents entry in the left side Guide-bar. Expand it to
see the main RA Topics.

& Help - € studio - O X

Search: Scope: All topics
Contents &@- ¥-B CohweAl@® 0

+ © Workbench User Guide RA Contents > ~
# € C/C++ Development User Guide

# € e2 studio User Guide Creating an RA pl“Oj ect

% € Eclipse Remote Developer's Guide

1 © EGit Documentation

of GNUARM-NONE/RZ(DS-5) Project Import
4 © Linker Script and Linker Script Editor

A new Renesas RA project is created using one of the RA C or C++ project wizards. The wizard selection page can be opened in one
of the following ways:

# € Oomph P2 M t Doc tati * The e2 studio [File->New->RA C/C++ Project] main menu
# € Oomph Setup Documentation * The Project Explorer view [New->RA C/C++ Project] context menu
= B RA Contents ¢ The 2 studio [New->RA C/C++ Project] toolbar drop-down

RA configuration editor
MCU Package View ‘Wizard selection page
RA user pack creator
RA Developer Assistance The wizard selection page allows you to choose the type of RA wizard to open. Wizards are available for either C or C++ and for an
How to create and use an RA static library RA Executable or Static Library project.
How to create an application project which uses &
Preferences for the RA Configuration Editor
B RAFAQ
% © Renesas Hardware Manuals
+ € Renesas QE for Capacitive Touch[RA]
# € Scripting User Guide

w

DEDD P @

[ New RA C/C++ Project o X

Templates for New RA C/C++ Project

Renesas RA C Executable Project
UG+ FE===N~ A C Executable Project for Renesas RA

Figure 44: RA Content Help

You can also search for help topics by using the Search bar. Below is an example searching for
Visual Expressions, a helpful feature in the e2 studio debugger.
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&) Help - € studio - O X
Search: visual expressions Scope: All topics
Search Results = D g D O mwelle 0

e2 studio User Guide > Debugging Projects > Views

6 matches in All topics: Change scope

The Visual Expressions view can show a visual Vlsual EXpreSSlons Vlew
representation of expressions that are presented
in the program's code. It is similar to the
Expressions view but with graphic...

e2 studio Plug-in list

) Visual Expression 3 E-#E -0

e2 studio Plug-ins The table lists some of the

plug-ins available in e2 studio. The table also lists esauss
who were the most recent developers of the view .
or plugin: Plug-in Name... A 4

Tuning Error Parsers PN i
Error Parsers scan build output line by line 2

looking for errors and warnings (also for certain
informational messages). They generate Problem
Markers which visually indicat...

, Overview
B Error Parser Preferences

Use the Error Parsers Tab on Build preference The Visual Expressions view can show a visual representation of expressions that are presented in the program's code. It
panel to define global error parsing options. is similar to the Expressions view but with graphical representations. Each graphically represented expression in the
Error Parsers scan build output looking for Visual Expressions view is referred to as a “visual element”.

potential error or warning messages....

[ ER : TR S TR N PRI S R L

Figure 45: e2 studio Help from the Search Bar

For a hands-on experience using the Help system use the Quick FSP Labs for An Introduction to
Developer Assistance, Creating Blinky from Scratch and Creating an RTC Blinky from Scratch. These
15-minute Do it Yourself labs take you through the step-by-step process of using Autocomplete,
Developer Assistance, and the Help system.

2.2.8.2 HAL Modules in FSP: A Practical Description

The FSP Architecture section describes FSP stacks, modules and interfaces in significant detail,
providing an understanding of the theory behind them. The following sections provides a quick and
practical introduction on how to use API functions when writing code and where in the API reference
sections you can find useful AP